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CowCalf5  

System Requirements 

The CowCalf5 Program requires the following minimum system resources in 

order to function properly. 

Windows 95/98/NT 

32 Meg Ram 

50 Meg Free Hard Disk Space 

Pentium Processor or better 

CD Rom Drive 

Electronic Scale or EID Reader (Optional) 

Installing the Program 

To install the program onto the hard drive, place the enclosed installation CD 

into the CD Rom drive.  The installation program should start automatically.  

By default the program will install into the C:\CowCalf5  subdirectory.  If 

you wish to install it into a different directory, simply identify this change 

during the setup process. 

The installation program will also create two additional subdirectories: 

PWRS and SQLANY50.  These directories are required for the program to 

function properly.  You must restart the computer following the installation 

to complete the installation process. 

Once the program is installed, a new CowCalf5 program option will be added 

to your Start Menu, Programs section.   

Creating a CowCalf5 Icon on your desktop 

The standard CowCalf5 installation creates a program group called CowCalf5 

in your Start Menu Programs.  If you would like to also place an icon on your 

desktop for easy assess do the following: 

For Windows 98 

Open up the Start Menu, Programs 

Locate the CowCalf5 folder, and open it 

Highlight the CowCalf5 program startup icon by placing the mouse over it 
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Press the Right Mouse Button, and select Send To: 

Then choose Desktop (create shortcut) 

This will place a CowCalf5 icon on your desktop 

For Windows 95/NT 

Open up Windows Explorer 

Locate the CowCalf5 folder and click it to open it 

Find the file named CowCalf5.EXE and click on the right mouse button over 

it 

From within the menu, choose Create Shortcut 

A file called Shortcut to CowCalf5 will be created at the bottom of the list 

of files.  Hold down on the left mouse button over this file and drag it to your 

desktop 

Open/New Herd 

CowCalf5 has the ability to store an unlimited number of herds.  Only one 

herd is accessible at any one time.  The title bar of the CowCalf5 program 

displays the current herd that is being used.  CowCalf5 automatically opens 

the last herd that was used when the program is started up.  A DEMO herd is 

provided with the installation program to be used for demonstration and trial 

purposes. 

To create a new herd, click on the FILE menu choice and choose NEW 

HERD.  You will be prompted for the name of the herd and other general 

information about this new herd like owners name and address.  Enter the 

name that you wish to call this herd (the name should be no more that 8 char-

acters long and contain no spaces). 

To open a different herd that you have created, click on the FILE menu and 

select OPEN HERD.  Double click on the herd that you wish to open.  



Start Entering Records 

When starting new herd records, there are certain steps you should 

perform to make entering the records go more smoothly.  The follow-

ing is a brief outline of the proper steps needed to get your records 

entered.  A more detailed explanation of the steps will be outlined in 

later sections. 

 

1. Create a new herd.  If a group of animals are managed totally 

separate from other animals, and they do not intermingle, then 

they should be stored in a separate herd.  Animals can be moved 

from one herd to another if the need arises. 

2. Enter all the Dams in the herd.  All the cows in the herd should 

be entered.  The only permanent information required for a cow 

is a birth date. 

3. Create a production year.   Create a production year for each 

year of production data that you wish to enter.  Only create his-

torical production years, future production year records will be 

created as the need arises. 

4. Add calving info for the years created.  Enter the calving data 

for each year.  You can only enter yearly data year by year, so 

enter one year’s data, then enter other year’s records if you have 

them. 

5. Add any other production data that you might have for each 

year.  If you wish to enter past breeding or pregnancy data, enter 

it for each year. 

6. Enter weaning info.  If weaning info is collected for the calves, 

enter it.  Once entered, you can run the weaning summaries. 

7. Promote calves.  If the calves were promoted to the feedlot, re-

placement heifers, or bull development, then promote them after 

entering weaning info. 

8. Enter any development data.  Enter the breeding/preg/weights 

etc. for heifers, or feedlot/bull dev data that you might have. 
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9. Promote heifers to dams. Any heifers that will remain in the 

herd need to be promoted to herd once it is determined that they 

are going to stay in the herd. 

10. Enter Disposal Info for Dams that die or leave the herd. All 

cows that leave the herd need to have a disposal reason and date 

entered as to why they left the herd. 

11. Create the next production year.  This will create a production 

year for all cows that are still in the herd, including the newly 

added heifers. 
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To enter new cows into CowCalf5, be sure that 

you are in the herd that you want the cows in-

cluded in.  See the Open/New Herd section for 

information on creating and opening herds in 

CowCalf5. 

From the Enter Data menu, select New Dams.  

The enter data screen will open, allowing you 

to adding new cows to your herd. 

See the Enter Data section of this tutorial for 

information on using the Enter data section. 

Enter a Dam’s ID in the ID 

field.  The program will 

search for that Dam ID in 

the current herd, and if it is 

not found, then you will be 

prompted if you wish to 

enter this dam to the herd,  

Simply click the Yes with 

the mouse or tab over to Yes 

and hit Enter.  You should 

enter any additional infor-

mation that you know for 

that animal.  CowCalf5 re-

quires that every Dam have a birth date entered.  If you don’t know 

the actual birth date, enter a date representative of when she should 

have been born, with the appropriate year so that her age (in years) 

will be calculated accurately.   

New Dams 

Entering New Animals 

Email: Support@COWCALF.COM 

Page 8 



Before you can enter new calving information you should first create a 

production year record for all the Dams that will calve that year.  Cow-

Calf5 will automatically create a record for every dam that should have 

a production record when you run the Create Production Year func-

tion from the Edit menu option.  The criteria used by CowCalf5 to de-

termine if a production record is needed for a particular Dam is: 

 The Dam doesn’t have a production record for that year  

 The Dam is at least 2 years old 

 Dams Origin Date is not after the production year 

 Dams Disposal Date is not prior to the production year 

When you run the Create Production Year routine, you will be dis-

played a list of the Dams that meet the criteria and will receive new 

production year record.  Review this list to make sure the list agrees 

with the animals that will be calving that year.  If the list is correct, then 

click on Proceed. 

You will notice that each dam will have that production year listed in 

the window in the upper left corner of the display/edit screen when that 

Dam is displayed. 

Create a New Production Year 

The only data that is required on a permanent dam is a unique id 

(must be unique across all years) and a birth date.  When a Dam is 

disposed or dies, CowCalf5 requires that you enter a disposal date. 
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Enter New Calves 

Once you have created a production year record for each Dam, you are 

now ready to start entering new calving 

data.  From the Cows tab page, select the 

year that you will be entering calving data.  

Go to the Enter Data menu, and select 

New Calves or Calving.  The enter data 

template, with a list of all the cow that 

should calve that year will be displayed. 

Type the first Dam’s ID in the upper left 

hand corner field, and press Enter.  The 

cursor will automatically scroll to that 

Dam’s production record, where you can then enter the calving data for 

that Dam.  Use the Tab key to jump between the fields of that record.   

When you are through entering data for that Dam, press F10, and the 

cursor will return to the upper left box, awaiting the entering of the next 

Dam’s ID.  Repeat these steps to enter all calving data. 

Be sure and save your changes periodically by clicking on the Save but-

ton on the bottom of the screen.  No 

changes are saved to the database until 

the Save Button is pressed.  Pressing the 

OK button, saves your changes and 

closes the Enter Data window, while the 

Save button, saves your changes and 

leaves the Enter Data window open. 

If you wish to change the order or select 

different variables for the Enter Data 

window, see the section on Enter Data 

for all the options available. 

The production year corre-

sponds with the year that 

the calf was weaned.  The 

production record contains 

all production data for 

both the Dam and calf 

from the start of calving to 

start of the next calving 

CowCalf requires that each 

calf have the following infor-

mation in order to function 

properly. 

 Unique ID (unique for 

that year) 

 Sex 

 Birth Date 

All other variables are op-

tional, depending upon the 

types of reports and analysis 

you wish to perform. 
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Entering Additional Production Data 

Additional production data can be entered any time after the production 

record is created for the Dam.  CowCalf5 has various predefined Enter 

Data forms that can be used for these functions.  If you wish to create 

your own Enter Data Forms, then see the section on Enter Data for addi-

tional info. 

 

Weaning 

Use the weaning worksheet to enter weaning weights for calves.  This 

form is based upon Calf ID’s.  To use this form correctly, have the 

Calves tab page open, and the correct year selected prior to opening this 

form.  Two data fields must be entered in order for CowCalf5 to be able 

to adjust and ratio weaning weights: the Weaning Weight and Weaning 

Date fields.  If desired, additional weaning information can also be col-

lected. 

To adjust and ratio weaning data, enter all weaning info and then go to 

the Reports menu selection and select Weaning, Summary.  This report 

will use the records for the year that is selected, and adjust the weaning 

weights within each sex contemporary group. 

 

Breeding/Post Weaning/Pre Calving 

Use these forms for entering Dam weights and condition scores collected 

during other times of the year.   

 

Pregnancy 

The Pregnancy Enter Data form is designed to enter pregnancy informa-

tion.  This is information that is collected at pregnancy checking time.  

You must stage pregnancies, and enter the equivalent number of days 

pregnant in the Days Pregnant field.  The date that Dam was pregnancy 

checked also needs to be entered.  Once both these fields are entered, a 

projected calving date is displayed, indicating when the Dam is projected 



Email: Support@COWCALF.COM 

Page 12 

to calve based upon the number of days pregnant. 

 

The Pregnancy Enter Data template will also display the projected num-

ber days pregnant based upon AI.  This number is calculated based upon 

the last AI date entered on the breeding record.   

If the Dam is Open, you can choose a Code from the drop down list.  

This Code is used to describe the reason why the Dam is open.  You can 

also use a 0 days pregnant for open Dams. 
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Promoting Calves 

If calves are kept after weaning, then they need to be promoted to the 

appropriate enterprise 

(feedlot, replacement heifer, 

or bull development) so that 

additional information can be 

collected.   When a calf is 

promoted to one of these 

enterprises, it gets additional 

tab pages on the display/edit 

screen. 

Retained calves should be 

promoted after their weaning weights have been adjusted (see Adjust-

ing Weaning Weights for info on adjusting weaning weights).  To 

promote a calf to one of three (feedlot, heifer, or bull development) 

enterprises, do the following: 

Go to the Calves Tab page 

From the Work Group menu, select Promote. 

Choose the appropriate enterprise (Calf to Repl Heifer, Calf to Bull 

Development, or Calf to Feedlot) 

A list of all the calves will be displayed, highlight each calf you wish 

to promote by clicking on the ID 

Once all ID have been selected, click on the Promote button. 

You will be prompted for a development ID for that calf.  If you 

change the ID at promotion time, enter it here. 

Note: A calf can be re-promoted to a different enterprise by simply 

doing the same steps, but selecting the different enter-

prise.    

To group or view the calves that have been promoted to a 

particular enterprise then simply click on the appropriate radio button 

on the bottom of the calves page.  Use this function when entering 

yearling and other development data for promoted calves. 

   

This calf has been promoted to a heifer, notice 

the additional tabs following the weaning tab.  

When calves are promoted to the feedlot or bull 
development, they get similar tabs correspond-

ing to the area they were promoted too. 
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Promoting Heifers to Dam 

Replacement heifers that have been breed and pregnancy checked, 

and determined that they are staying in the herd should then be pro-

moted to Dams.   

If you will be changing the ID’s of the Heifer calves when you pro-

mote them to dams you can either assign them ahead of time or when 

you are promoting them.  To assign these new ID’s prior to promot-

ing, simply enter the new Dam ID in the Permanent ID field located 

on the Replacement Heifer record.  If you have not entered a ID in the 

Permanent ID field, then you will be prompted for the permanent ID 

during the promotion process. 

To promote them to dams, then do the following: 

Click on the Calves tab page 

Click the Repl Heifer radio button to display just the replacement 

heifer calves. 

Goto the Work Group Menu, and select Promote. 

Select Replacement Heifers to Dam. 

A list of all the replacement heifer calves will be displayed, select 

each the calf that you wish to promote by clicking on the ID. 

Once all the ID’s you wish to promote are selected, click the Promote 

button to promote them to Dams. 

If you have not entered a Permanent ID on the Replacement Heifer 

record, then you will be prompted for the new ID for each heifer. 

Promoting Bull Development to Bulls 

After bull calves have been determined that they will be staying in the 

herd as herd sires, should be promoted to Bulls (herd sires).   

If you will be changing the ID’s of the bull calves when you promote 

them to bulls, you can either assign them ahead of time or when you 

are promoting them.  To assign these new ID’s prior to promoting, 

simply enter the new Bull ID in the Permanent ID field located on the 

Bull Development record.  If you have not entered a ID in the Perma-

nent ID field, then you will be prompted for the permanent ID during 

the promotion process. 
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To promote them to bulls, do the following: 

Click on the Calves tab page 

Click the Bull Develop radio button to display just the bull development 

calves. 

Goto the Work Group Menu, and select Promote. 

Select Bull Dev to Perm. 

A list of all the bull development calves will be displayed, select each the 

calf that you wish to promote by clicking on the ID. 

Once all the ID’s you wish to promote are selected, click the Promote 

button to promote them to permanent Bulls. 

If you have not entered a Permanent ID on the Bull Development record, 

then you will be prompted for the new ID for each bull. 
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Enter Data 

Using Predefined Forms 

CowCalf5 comes with many Enter Data templates to make data entry 

easy.  These templates are available for events from entering new dams 

and calves to entering weaning and pregnancy data.  Depending upon if 

you are on the Cows, Calves or Bulls tab will determine which templates 

are available from the Enter Data menu option. 

If you are entering dam’s data like pregnancy, breeding, weights, or calv-

ing data, then you want to have the Cows tab page open. When entering 

weaning data, the Calves tab page with the All Calves button clicked 

needs to be active.  To enter bull data, be sure and have the Bull tab page 

active. 

In order to use a Replacement Heifer, Bull Development, or Feedlot enter 

data form, the Calves tab page needs to be active and the appropriate 

radio button in the lower left selected.  

Select Variables 

If the included data entry forms don’t contain the variables that you wish 

to enter, you can create a customized Enter Data template that contains 

the variables desired.  From the Enter Data menu, select Select Vari-

ables.  You will be prompted how you wish to enter the data by.  Gener-

ally, you will enter the data by Dam ID.  You can also do it by Calf ID or 

a Development ID.  This ID will be located in the first column, and you 

will use this ID to identify which record you wish to update. 

A screen will open, with the upper left window containing a list of all the 

variables that are available for the selected category.  The lower half of 

the window displays all the categories available, and which ones are be-

ing used.  It is best to utilize variables from only one of the main cate-

gory types (Perm Dam, Prod Dam, Heifer, etc.).  Mixing variables from 

multiple categories can cause a malfunction, though if done properly, it 

works. 

To select the variables that you want to work with, simply locate the vari-

able name in the upper left window, click on it with the left mouse but-

ton, and holding down the left mouse button, drag it to the upper right 

hand window.  Do this for all the variables that you desire and then press 

the OK button. 
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Sorting columns 

There are two ways to sort the data in a column(s).  The first is to simply 

double click the left mouse button on the column header.  This will 

sort the column ascending, and double clicking the column again will 

sort it descending. 

The second method is to use the menu and select Edit, and Sort.   A 

screen will open, listing all the variables available in the left window.  

Simply drag (holding down the left mouse button) the variables you wish 

to sort on into the right hand window.  If you select more than one vari-

able, the others will be a secondary sort after the primary (first variable 

on the list).  Click OK to sort the data based upon the variables selected. 

Reordering 

You can change the order that the variables are displayed on screen by 

simply clicking on the column header and drag (click and hold down the 

left mouse button) the column to the new location and let up on the 

mouse button.  

To change the size of the columns, place the cursor on the col-

umn boundary, in the header row, until a double arrow appears.  

Hold down the left button and drag to the size desired. 

Batch Entry 

If you want to enter the same data into a particular variable for all the 

records displayed, then you want to Batch enter the data into the column.  

Click on the column header (be sure to click on the text of the header) 

and the Batch Entry button will enable.  Click on the Batch Entry button 

and type in the value to be entered into all the records.  Once you press 

OK, that value will be entered for all the records. 

Saving a Form 

If you created a customized enter data form that you 

want to be able to use multiple times, then you can save 

it for later use.  After you have selected the variables, 

and are using the customized form, to save it, simply 

select File from the menu and choose Save Form As.  

You will be prompted for the name that you want to as-

sign this form design. 

Using Batch 

Entry is an 

excellent way 

to delete data 

as well.  



Email: Support@COWCALF.COM 

Page 18 

To retrieve a Saved form, simply choose the Enter Data menu, and 

select Use Saved Form, and select the saved form from the list. 

Editing Forms 

If you wish to change the order of or variables selected from a form 

then use the Edit Form choice under Enter Data.  You can edit ei-

ther a saved form or the last enter data form that was created.  Choose 

the form that you wish to edit, and the Create Enter Data Template 

window will be displayed with the variables previously selected 

shown.  Make the appropriate changes and press OK to use the up-

dated template.   

Customizing Predefined Forms 

You should have noticed that when you saved an Enter Data Tem-

plate that there were many forms already saved whose filename be-

gan with CC5_.  These are the predefined forms that CowCalf5 ac-

cesses from the Enter Data Menu.  From the name of the file, it 

should be evident which form is for which menu choice.   

You can use the Edit Forms, and select one of 

these forms to customize the predefined forms 

that come CowCalf5.  Once you have made the 

changes, be sure to go to Save Form As and 

overwrite the existing form if you want to make 

this new form the default for the menu choice. 

If you want to 

remove a vari-

able that was 

selected, simply 

drag it back to 

the left window. 
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Reports 

Weaning Summary 

Once you have entered weaning weights, then you are ready to adjust  

them and summarize the performance of each dam.  In order to adjust 

weaning weights, the following variables must have been entered: 

The weaning summary report will utilize the group of animals listed in 

the left hand list.  For most herds, this group should probably be all 

calves for a particular year.  For larger herds though, it may be desirable 

to utilize a smaller workgroup of animals.  To round up a new workgroup 

see the section on Creating a Work Group later in this manual. 

To run the Weaning Summary, have the Calves tab page open, and the 

appropriate Year or Workgroup selected.  Choose Weaning from the 

Reports menu.  Then choose Summary to run the Weaning Summary. 

You will then be prompted if you want to Update Calculated Fields.  If 

you select Yes, then the weaning weights will be (re)adjusted and wean-

ing ratios and ranks will be calculated.  If you choose No, then no adjust-

ments will be calculated, and just the reports will be created using any 

values stored on each record.  Note: Choose No if you have already ad-

justed weaning weights and just want to view the reports again. 

The Weaning Calculation Info window will be displayed prompting you 

for default adjustment values.  Enter the 

number of days that you want the weaning 

weights adjusted to (this should be the av-

erage age of the calves).  Then choose if 

you want to use Additive or Multiplica-

tive adjustments (most herd associations 

recommend Additive). Enter the default 

date that the calves were weaned (this date is used if a calf has a weaning 

weight, but the weaning date field is not entered.   The click OK to view 

Dam Unique ID 

Dam Birth Date 

Calf ID (Unique for that year) 

Calf Birth Date 

Calf Sex 

Calf Birth Weight (optional) 

Calf Weaning Weight 

Calf Weaning Date 

Calf Rank must  0 
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the weaning summary reports. 

Yearling Summary 

In order to adjust yearling summaries, the following is required: 

To adjust yearling weights, select the Calves tab page, and the appropri-

ate development radio button in the lower left window.  Select the year 

of the calves that you are going to adjust, and the calves should be listed 

in the window.  Select Reports from the menu, select the development 

type (ex, Replacement Heifer) , then choose Yearling Summary. 

You will be asked if you wish to update calculated fields.  Click on Yes 

to (re)adjust the yearling weights.  Choose No if you want to just recreate 

the yearling summary reports without (re)calculating adjustment values. 

Then a window will be displayed requesting the number of days that the 

weaning summary used for the adjusted age at weaning.  Clicking OK 

displays the yearling summary reports.  

Notes about Reports 

The main thing to remember when running any report is that the animals 

that will be included in the reports is based upon what animals listed in 

the left window on the display edit screen.   

Any report can be printed by clicking on the File menu and choosing 

Print when that report is being displayed on the screen.   

Reports can be saved to a variety of different types of files by selecting 

Save As from the File Menu when the report is displayed on the screen.  

If the report contains summary data, then the file that is created will con-

tain all the data that was summarized, not the summary data as displayed 

in the report. 

Dam Unique ID 

Dam Birth Date 

Calf ID (Unique for that year) 

Calf Birth Date 

Calf Sex 

Calf Birth Weight (optional) 

Calf Weaning Weight entered 

Calf Weaning Date entered 

Calf must be or have been promoted 

Yearling Weight entered 

Yearling Date entered 
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Work Groups (WGP) 

What are Work Groups 

CowCalf5 utilizes subsets of the whole herd when ever performing any func-

tion like enter data or reports.  On the main screen, a year and list of dams/

bulls/calves that correspond to that year are displayed.  Generally, this work 

group of animals is the appropriate group needed to run functions within 

CowCalf5.   

Occasionally, there is a need to sub group this list of animals further.  In this 

case, the need to create a new work group is required.  Work groups can be 

created utilizing any variable or combination of variables used in the program.  

Because of this extreme power, it is advised that you have a good feel for 

your data and the database structure of CowCalf5 before using this function. 

Creating a New Work Group 

To create a new work group, select Work Group from the Main Menu, and 

click Create New.  A screen will be displayed requiring you to put in your 

search criteria.   

The first thing you should do is identify what category (perm dam, prod dam, 

etc.) of variables you will be using.  Although CowCalf5 supports selecting 

variables from different categories, it is advised to try and keep your selection 

of variables from within the same category. 

In the Display Column select the variable name that you wish to sort on.  If 

you click on the drop down list, you will be displayed a list of all variables for 

the category you selected. 

In the Operator field select what you want the variable to be, for example = 

(equal to) , > greater than, etc.  In the Value field, type in the value for the 

search criteria you are looking for.  If you wish to search multiple columns, 

then select AND or OR from the Logical field and add an additional line of 

criteria. 

When finished, press the Search button to find the animals.  You will be 

prompted for a name for this workgroup. This name will be listed in the year 

drop down box on the main page if you want to retrieve it again. 
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Customizing CowCalf 

Editing Codes 

Many fields within CowCalf5 are coded fields.  These codes can be cus-

tomized to meet the needs of each herd.  The following codes should be 

changed for each herd: Pastures, Management Groups and Calendar 

Categories.  The Health and Disposal codes should be edited to corre-

spond with herd management terminologies. 

To edit codes select Edit from the Menu and choose Edit Codes.  Select 

the appropriate category and code that you wish to edit.  A window will 

be displayed listing all the current codes for the particular code you 

chose.  It is advised that you change the wording for codes that exist, and 

add new codes in blank slots provided.  A code number/letter will corre-

spond with each code.  This code number/letter is used by the software to 

minimize the database size, and is not important to the end user. 

Editing Function Keys 

There is a function that is available for enter data that can be used to 

speed up repetitive data entry.  If you will be entering the same data in 

multiple fields, you can assign a function key to the value.  Then by sim-

ply placing the cursor in the appropriate field and pressing the function 

key, the value will automatically be inserted in that field. 

To change the values assigned to function keys F2, F3 or F4, select Edit 

from the menu and choose Edit Function Keys.  A window will be dis-

played showing the current settings for each function key.  Each function 

key can contain any text or number, or a function.   

Use the Today function to put in today’s date.  The Current Time func-

tion puts in the current time.   The Random function places a random 

number from 0 – 9 in the field.   If you assign a function key a number, 

you can click on the increment box to have that number automatically 

increment by 1 each time the function key is pressed.  

Auto Save Timer 

When you are entering data using the Enter Data feature,  many changes 

can be performed on many records without saving these changes to the 

database.  These changes are stored only in the memory of the computer.  
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If the computer would happen to lock up or get shut off, all these changes 

would be lost.   

CowCalf5 has a feature to set up a reminder to save your changes at 

regular intervals.  The default interval is to remind you to save once 

every 15 minutes.  If you wish to change this interval or disable this func-

tion, you need to change the setting in the Edit, Preferences, Herd In-

formation menu selection.  Valid intervals are anywhere from 1 to 60 

minutes.  If you set the interval to 0 (zero) then the auto reminder is dis-

abled and will not prompt you to save your data a regular intervals. 

EID Readers 

CowCalf5 supports various Electronic ID readers.  If you would like in-

corporate EID’s into your records, first configure CowCalf5 for the type 

of EID reader that you have.  Go to the Select Preferences from the Edit 

menu choice, then choose Equipment Setup.  A window will be dis-

played indicating the various types of EID readers available.  Select the 

Reader and Communications Port that the reader is attached. 

When using Enter Data, place the cursor in the field to enter the EID and 

press the F6 function key to read the EID tag from the reader.  If you 

have previously entered EID’s into your database, then in Enter Data, 

press F10 to prompt for a new ID, press F6 to read a new ID, and when 

you press Enter, the cursor should go to that animal’s record. 

Electronic Scales 

Electronic Scales work the same as EID’s.  See the section on EID’s for 

information on how to configure Electronic Scales.   

To read the weight of an electronic scale into a weight field, place the 

cursor in a weight field, and press F4 (read scale).  A window will open, 

with the weight that is currently on the scale head flickering.  When the 

weight balances out, press OK to enter that weight into the field. 
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Importing Data 

Data can be imported into CowCalf5 from various sources.  The only 

requirement for importing data is that the text file must be in tab delim-

ited (separated) format.  A tab delimited file is a file in which each field 

(variable) is separated by a Tab.  Most all spreadsheet and database pro-

grams can export data in this format. 

Importing data works very similar to Enter Data, using a custom work-

sheet.  You create a custom enter data worksheet that identifies the vari-

ables that you will be entering in the order that they appear in the text 

file.  You then identify the (tab delimited) text file that you wish to im-

port.  A window will open displaying the data in the columns that they 

will be imported into.  If the data looks correct, click the OK button. 

A log file will open, displaying all the errors that occurred during the 

importing.   

The following key fields are required when importing data: (these vari-

ables must be included in your text file) 

 

Type of Data Importing  Primary Fields Needed 

Permanent Dam Dam ID 

Production Dam 
Dam ID 

Production Year 

Replacement Heifer 

Development ID 

Production Year 

Development Type  (H) 

Feedlot 

Development ID 

Production Year 

Development Type (F) 

Bull Development 

Development ID 

Production Year 

Development Type (B) 



  

Page 25 

Data can be exported from CowCalf5 from either Enter Data or from the 

Reports section.  Using the Enter Data feature, you can identify which 

columns and what order you wish to have the data in when you export it. 

To Export Data from with in the Enter Data function, have the data dis-

played on the screen as you wish to have it exported, and choose Save As 

from the File menu.  You will be displayed a pop up window prompting 

for the name and location to save the file, as well as the type of file that 

you wish to export.  Depending upon what you are exporting the data to, 

will determine what type of file to create.  Generally, most programs can 

read data that is either tab (Text) or comma (CSV) delimited.  If you are 

exporting it to Excel, choose the HTML TABLE type.  This will create a 

file with the extension of HTM, which can be opened in Excel.. 

When exporting a CowCalf5 report, follow the same steps.  Display the 

report you wish to export to the screen.  Select the Save As menu choose 

and identify the name, location and type of file to export.  Summary re-

ports and graphs will export the data that makes up the report NOT the 

actually summary data that is displayed on the screen. 

Exporting Data 



Appendix 

Email: Support@COWCALF.COM 

Page 26 

Overview 

CowCalf5 is specifically designed to take full advantage of the Windows 

environment.  As such, CowCalf5 will not run on machines running DOS 

or Windows 3.  CowCalf5 has been tested fully compatible with Window 

95/98, NT4, 2000 or XP and should have no problems running on new 

versions of the Windows operating system.   

CowCalf5 is a program that utilizes a Sybase SQL Anywhere database 

engine, which makes for very quick data access and analysis.  When 

CowCalf5 starts up, the database engine will also be started.  Users will 

notice a separate icon on their start bar for the CowCalf database, this 

program can not be closed during the normal operation of Cow-

Calf5.  The database engine closes when CowCalf5 is shutdown prop-

erly.  If CowCalf5 in not closed properly, then the database engine may 

remain open.  To close it simply double click on the icon, and press the 

Shutdown button displayed on the window. 

 

Database structure 

CowCalf5 utilizes a single database for all herds.  This format makes it 

possible to do across herd summaries and comparisons.  The database is 

made up of 5 primary database tables.  These tables are important to 

know and understand the relationships between them.   

The Permanent Dam table is where the permanent information about 

each dam is recorded.  This table includes all cows both current and those 

that have been culled from the herd.  This table requires that there be no 

duplicate dam ids for any herd.  Because of this, you can NOT duplicate 

Dam Ids within a herd, even it one of the animals had been disposed of 

previously.    

The Production Dam table is where yearly production data is stored.  

The Production table is linked to the Permanent Dam table.  Only Dams 

that are in the Permanent Dam table can have entries in the Production 

Dam table.  The Production Dam table has a field for Production Year.  

Each year that a Dam is in the herd, she will get a new Production record.   
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On the Production record goes information such as breeding information 

that happened to her for that year, any weights/condition scores for the 

dam, and information about the calf that she raised that year.  Each dam 

will get a new Production record for each year that she is in the herd.  

Once a Disposal Date has been placed on the Dam record, CowCalf5 will 

prevent that Dam from getting subsequent Production Years.   

The Development table contains information about the calf if it is re-

tained past weaning.  Replacement Heifer, Feedlot, and Bull Develop-

ment records are all contained within the Development table. 

 

Development records can be created by promoting calf records from the 

Production table, or created from scratch.  Development records don’t 

need to be associated with a Dam that is already in the database.  As 

such, CowCalf5 allows adding purchased Heifers, Bull Development, 

and Feedlot records directly into the Development table.  Records that 

are added in to the development table must be associated with a produc-

tion year, and have an associated development type of either Heifer, Bull 

Dev, or Feedlot.  Do NOT create new development records if a previous 

production record had been created.  Use the promote feature to create 

the record with all the historical data being transferred and appropriate 

links established. 
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